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				If you're interested in splitting your PDFs into images, the best possible way is to use an online tool like "PDF to JPG". It's a conversion tool that helps in converting PDFs to JPGs, JPEGs, or PNGs within seconds. Here's how you can use it to convert a document into images:




			

		

	




Convert PDF To Image Online





	
		
			
					Go to https://www.formatpdf.com/en/pdf-to-jpg/
	Click the red button that says "Select PDF file" or drag your PDFs directly to the space with the text "Or drag and drop the PDF here".

If you've chosen the first option, select the PDFs you want to convert into an image format.
	Wait for a second, and your PDF document(s) will appear on the screen. You'll see a new red button at the right of the screen that says, "Convert to JPG". Click on it to start the PDF to JPG conversion process.
	Once the conversion process is finished, you'll need to tap the "Download JPG" button. By clicking on the button, you'll start the download process. Getting your JPEG, JPG or PNG file ready might take a few moments.





			

		

	



	
		
			
				Use Our Tool Now: From PDF To JPG Online


			

		

	



	
		
			
				Once you have done this, keep in mind that you can also convert JPGs back to PDFs. Remember that the PDF format allows you to work with more actions like compressing the PDF to make it weigh less, splitting it into more PDFs, rotating it, or converting PDFs to other formats like Word.
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Why Split A PDF Into Images?

	Web Publishing: Websites often require images rather than PDFs for compatibility and quicker load times.
	Presentations: To insert specific PDF pages into PowerPoint or Keynote slides as images.
	Email Attachments: Some email systems have size limits for attachments; splitting a PDF into images can reduce the size of each individual attachment.
	Document Editing: When the source document is not available, converting PDF pages to images allows for editing in image editors.
	Graphic Design: To use elements from a PDF page in graphic design software that may not support PDF files.
	Printing: Sometimes, printing individual images may be easier or yield better results than printing from a PDF, especially for large format or high-quality prints.
	Image Embedding: To embed PDF content into video editing or 3D modeling software that does not support PDF import.
	File Size Management: Splitting a PDF into images can sometimes reduce the overall file size, making it easier to manage and share.


What You Need To Know About Splitting A PDF Into Images

When splitting a PDF into images, here are several key points to consider:

	Purpose of Splitting: Determine why you need to split your PDF into images, as this will influence how you approach the task (e.g., for presentation, web use, editing).

Image Format: Decide on the preferred image format for the output (JPG, PNG, TIFF, BMP, etc.), considering quality and file size.
	Image Quality: Higher resolution and quality settings result in better image clarity but also larger file sizes.
	Legal Restrictions: Be aware of copyright laws or any restrictions that may apply to the content within the PDF.
	Output Management: Plan how to manage the output files, including naming conventions and storage locations.
	Time Required: The process can take time, especially for large documents or high-quality image outputs.



			

		

	



	
		
			
				Take A Look Here: How To Split A Password-Protected PDF


			

		

	



	
		
			
				Alternative Programs To Split A PDF Into Images

Despite online tools being one of the best methods, some people might want to use other methods too. And if you're one of them, this section is for you. Luckily there are several ways to split PDFs into images, and we'll discuss the best one for each operating system.

Windows

Here are two alternatives for splitting a PDF into images on Windows devices, with step-by-step instructions for each:

1. Adobe Acrobat Pro DC

Adobe Acrobat Pro DC is a comprehensive PDF solution that allows you to convert PDF pages into various image formats.

Steps to split a PDF into images using Adobe Acrobat Pro DC:

	Open Adobe Acrobat Pro DC and load the PDF file you want to convert by clicking on "File" > "Open..." and selecting your document.
	Navigate to the right-hand pane and click on "Export PDF."
	In the export window, select "Image" as your export format and choose the specific image format you require (e.g., JPEG, PNG, TIFF).
	Click on the gear icon next to the image format if you wish to change settings like image quality or resolution.
	Specify the page range if you do not want to convert the entire document.
	Choose the output folder where you want to save the images by clicking on the "Save To" button.
	Click on the "Export" button to start the conversion process. The PDF pages will be saved as separate image files in the chosen directory.


2. PDF-XChange Editor

PDF-XChange Editor is another versatile tool for managing PDF documents, allowing users to convert PDF pages into images.

Steps to split a PDF into images using PDF-XChange Editor:

	Open PDF-XChange Editor and import the PDF file by clicking "File" > "Open..." and selecting your document.
	Go to the "Export" tab on the toolbar.
	Click on "Export to Image" and a dialog box will appear.
	In the dialog box, select your desired image format (e.g., PNG, JPEG, BMP).
	Configure the settings for the output image, such as DPI (dots per inch) for image quality.
	Choose which pages you want to export. You can export all pages, the current page, or define a range of pages.
	Select the destination folder where you want the images to be saved.
	Press "OK" or "Export" to start the conversion. Your PDF pages will be exported as individual image files to the specified location.


Mac

On a Mac, there are several built-in and third-party applications you can use to split a PDF into images. Here are two alternatives with step-by-step instructions for each:

1. Preview

Preview is a built-in app on macOS that can handle a variety of image formats and PDF files. It allows you to export individual pages of a PDF as images.

Steps to split a PDF into images using Preview:

	Open Preview by double-clicking on the PDF file, which should open by default in Preview. If not, right-click on the PDF file, select "Open With," and choose "Preview."

If the thumbnail sidebar is not visible, click on the "View" menu and select "Thumbnails" to show page thumbnails.
	Select the pages you want to convert to images by clicking on the thumbnails. You can select multiple pages by holding down the Command key while clicking.

Once selected, click on "File" in the menu bar, and then choose "Export Selected Images..." If you want to export a single page, you can also just click "Export as PDF..."
	In the export dialog, choose the format you want from the "Format" dropdown menu (e.g., JPEG, PNG, TIFF).
	Choose the quality and resolution if available for the chosen format.
	Select the folder where you want to save the images, enter a name for the files, and click "Save."


2. Automator

Automator is another built-in macOS application that can create custom workflows, including one to split a PDF into images.

Steps to split a PDF into images using Automator:

	Open Automator from the Applications folder or using Spotlight search (Command + Space, then type "Automator").
	In Automator, select "Workflow" as the type of document.
	In the Library of actions on the left, search for "PDFs" and then drag "Render PDF Pages as Images" to the workflow area on the right.
	Add the action "Copy Finder Items" to the workflow if you want to make sure to keep the original PDF intact.
	You can then set the desired image format and resolution in the options for the "Render PDF Pages as Images" action.
	Save your workflow with an appropriate name and location.
	To use the workflow, you can either drag and drop PDF files onto the Automator application where you saved the workflow or run the workflow from within Automator and select the PDF files when prompted.


Linux

On Linux devices, there are several powerful, free, and open-source tools for manipulating PDF files. Here are two alternatives with step-by-step instructions:

1. pdftoppm (Part of the Poppler Utilities)

pdftoppm is a command-line tool that converts PDF pages to image formats like PNG, JPEG, and others. It is typically pre-installed with most Linux distributions as part of the Poppler utilities.

Steps to split a PDF into images using pdftoppm:

	Open a terminal window.
	Navigate to the directory containing your PDF file using cd /path/to/directory/.
	Use the pdftoppm command to convert the PDF to images. Here's the basic syntax:
	pdftoppm -jpeg yourfile.pdf outputname



	This command will create JPEG images of each page named outputname-1.jpg, outputname-2.jpg, etc.
	If you want to convert to a different image format, replace -jpeg with -png or -tiff.
	To specify a range of pages, use the -f (first page) and -l (last page) options.
	If you want to specify the resolution, use the -r option followed by the DPI value.


2. ImageMagick's convert Command

ImageMagick is a software suite to create, edit, compose, or convert bitmap images. It can read and write images in a variety of formats (over 200) including PNG, JPEG, JPEG-2000, GIF, TIFF, and more.

Steps to split a PDF into images using ImageMagick's convert:

	Open a terminal window.
	Install ImageMagick if it's not already installed by running:
	arduino
	Copy code
	sudo apt-get install imagemagick
	Or use the package manager relevant to your distribution.



	Navigate to the directory containing your PDF file using cd /path/to/directory/.
	Use the convert command to convert the PDF into images:
	sql
	Copy code
	convert -density 300 yourfile.pdf -quality 100 outputname.png
	This will create a series of images named outputname-0.png, outputname-1.png, etc., with a resolution of 300 DPI and full quality.



	Adjust the -density value to change the resolution of the output images.
	Change the output format by replacing outputname.png with the desired format (e.g., outputname.jpg).


Android

Below are two alternatives with step-by-step instructions on how to split a PDF into images on Android devices:

1. Xodo PDF Reader & Editor

Xodo is a versatile PDF reader and editor that's available on the Google Play Store and allows for basic manipulation of PDF files, including extracting images.

Steps to extract images from a PDF using Xodo:

	Install Xodo: Download and install the Xodo app from the Google Play Store.
	Open the PDF: Launch Xodo and open the PDF file you want to work with.
	View in Thumbnails: Switch to thumbnail view where you see all pages as small images.
	Select Pages: Long press on a page thumbnail to enter multi-selection mode. Then select all pages you want to convert to images.
	Export Pages: After selecting the pages, look for an option to export or share pages in the top menu bar (often represented by a share icon) and choose to save or share as images.
	Choose the Image Format: If prompted, select the desired image format (usually PNG or JPEG).
	Save the Images: Choose where to save the images on your device or share them directly from the app.


2. PDF Utils

PDF Utils is a straightforward and lightweight app for PDF manipulation that includes conversion of PDF pages to images.

Steps to convert PDF pages into images using PDF Utils:

	Install PDF Utils: Get the app from the Google Play Store and install it on your Android device.
	Open the App: Start the app and select the "Select PDF" button.
	Choose the PDF: Navigate to the PDF file you wish to split into images and select it.
	Select 'Extract Images': From the provided options, tap on 'Extract Images'.
	Specify Options: If the app provides options for image quality or page range, specify your preferences.
	Perform Extraction: Tap on the “Extract” or “Start” button to begin the conversion process.
	Save or Share: Once the images are extracted, save them to your device, or use the share option to send them to another app or contact.


iPhone (iOS) Or iPad

On iPhone devices, you can use various apps to split a PDF into images. Here are two alternatives with their step-by-step instructions:

1. PDF Expert by Readdle

PDF Expert is a versatile app that allows you to read, annotate, and manage PDFs, including the ability to export pages as images.

Steps to split a PDF into images using PDF Expert:

	Install PDF Expert: Download and install PDF Expert from the App Store.
	Open the PDF: Launch PDF Expert and open the PDF file you want to convert.
	Select the Pages: Tap on the thumbnail icon to view all pages as thumbnails. Then tap "Select" in the upper right corner and choose the pages you want to export.
	Export as Images: Tap on “More” in the upper right corner of the screen (or the share icon), and then select “Export.”
	Choose Image Format: Choose the format for your images, like JPEG or PNG.
	Save or Share: Save the images to your iPhone, or choose an app to share them directly.


2. Adobe Acrobat Reader for PDF

Adobe Acrobat Reader is a well-known PDF utility that allows for various PDF operations, including converting PDF pages into images.

Steps to split a PDF into images using Adobe Acrobat Reader:

	Install Adobe Acrobat Reader: Get it from the App Store if you haven’t already.
	Open the PDF: Start Adobe Acrobat Reader, browse to find the PDF you want to convert, and open it.
	Select Export PDF: Tap on the bottom menu to find the export option, which may also appear as a share icon.
	Choose Output as Image: In the export options, select "Image" as the export format.
	Select Pages: Specify the range of pages you want to convert if you do not want to convert the whole document.
	Export and Save Images: Proceed with the export, and then save the resulting image files to your device or share them using the iOS share sheet.
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											FAQs About How To Split A PDF Into Images 

							
			
			
								
					
					
						
						  
							

																	
									
								 
								
									What does splitting a PDF into images mean?								
							

						  
						

						
						  
							  
							     Splitting a PDF into images means converting each page of a PDF file into a separate image file, such as JPEG, PNG, or TIFF.							  
						  

						

					

					
					
								
					
					
						
						  
							

																	
									
								 
								
									How can I split a PDF into individual images?								
							

						  
						

						
						  
							  
							     To split a PDF into separate images, you can use our specialized online tool. Typically, you'll upload your PDF, choose the image format and quality settings, and then download the resulting images. Be sure to select the appropriate resolution and image quality based on your requirements.							  
						  

						

					

					
					
								
					
					
						
						  
							

																	
									
								 
								
									Are there any specific image formats recommended for splitting PDFs?								
							

						  
						

						
						  
							  
							     When splitting a PDF into images, the most common image formats are JPEG (Joint Photographic Experts Group) and PNG (Portable Network Graphics). JPEG is a compressed format that's suitable for photographs and images with gradients, while PNG is a lossless format that supports transparency and is great for images with text or sharp lines. Your choice depends on the content of the PDF and your intended use for the images. For high-quality images, PNG is preferable, but for smaller file sizes, JPEG might be more suitable.							  
						  

						

					

					
					
								
					
					
						
						  
							

																	
									
								 
								
									What should I consider when splitting a PDF with multiple pages into images?								
							

						  
						

						
						  
							  
							     When splitting a multi-page PDF into images, keep these factors in mind:
	Resolution: Choose an appropriate resolution for your images. Higher resolution is better for printing or detailed images, while lower resolution is suitable for online sharing.
	Page Size: Make sure the dimensions of the images match your desired output size. You might need to crop or resize the images afterward.
	File Naming: Consider how you want the images to be named. Many tools can automatically name the images based on the PDF's page numbers or content.
	Output Format: Decide whether you want JPEG, PNG, or another image format, based on your quality and transparency needs.
	Quality Settings: Adjust the compression or quality settings based on whether you prioritize image quality or file size.
	Organization: Plan how you'll organize the resulting images, as splitting a large PDF could generate numerous files.

							  
						  

						

					

					
					
								
					
					
						
						  
							

																	
									
								 
								
									Why would I want to split a PDF into images?								
							

						  
						

						
						  
							  
							     You might want to split a PDF into images for easier sharing on platforms that don't support PDFs, to insert PDF pages into image-based documents, or for graphic design purposes where individual images are required.							  
						  

						

					

					
					
								
					
					
						
						  
							

																	
									
								 
								
									What do I do if the PDF is protected and I can't split it into images?								
							

						  
						

						
						  
							  
							     If the PDF is protected by copyright or a password, you’ll need the appropriate permissions or the password to unlock the PDF before you can split it into images legally.							  
						  

						

					

					
					
							

			
	

			

		

	





	
		
			
				Update History: 07/11/23 Added 'Why Split A PDF Into Images?' and 'What You Need To Know About Splitting A PDF Into Images' sections, and more FAQs, plus GIF screenshot.
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